Styles and Table of Contents in Word 2013

Contents

Introduction to Styles .......................................................... 2
Location of Style Related Commands ........................................ 2
Applying a Style to Selected Text .............................................. 3
  Applying a Style Method 1: Selecting a Style from the Quick Styles Gallery ................................................................. 4
  Applying a Style Method 2: Using the Styles Task Pane ................. 4
  Applying a Style Method 3: Using the Mini Toolbar ....................... 4
  Applying a Style Method 4: Using Keyboard Shortcut keys .......... 4
Modify a Style ........................................................................ 5
  Modifying a Style Method 1: Using the Modify Style Dialogue Box .................. 5
  Modifying a Style Method 2: Using the Update to Match Selection Option .......... 5
Further Features for Styles ........................................................ 6
  Setting the New Style to be Available from all New Documents ........ 6
  Viewing Attributes of a Particular Style .................................... 6
  Managing Styles ................................................................. 7
Selecting Text with Similar Formatting ........................................ 8
Table of Contents ..................................................................... 8
  Marking Entries for a Table of Contents .................................... 8
  Creating a Table of Contents Based on In-Built Heading Styles ........ 8
  Modifying the Table of Contents After you have Created It .......... 10
Formatting Text in a Table of Contents ........................................ 10
  Updating the Table of Contents ............................................. 11
Deleting a Table of Contents .................................................... 11
Working with Numbered Headings ............................................ 12
Tips for Working with Styles ................................................... 13
  1. Collapsing Text Under a Heading ........................................... 13
  2. Working With The Navigation Pane ...................................... 13
Introduction to Styles

A style is a collection of any number of formatting features (such as font, font colour or size, alignment, indentations, borders and shading) all rolled into one command. A style can include paragraph and/or character formatting. When a style is applied to selected text all the formatting instructions are applied at once. Styles are very useful when formatting headings and sub heading of long documents. This saves you time and ensures consistency in formatting attributes. If you change your mind about the font size or any other formatting attribute of a style you can simply modify the style and all the text which has the style applied is updated too. You can use Word’s in-built styles or create your own. This guide will focus on using the in-built styles.

Word provides you with a series of in-built styles ready for you to use. For example, there are usually 9 preset heading styles called Heading 1 to Heading 9. Heading 1 is usually Arial font, 14 pts, bold, left aligned, 24 pt space above the text. Heading 2 is designed to be a subheading style to go with Heading 1.

**Heading 1**  **This style is useful for top level headings**

**Heading 2**  **This style is useful for sub headings**

Using styles to apply formatting to headings in your document will not only save you a considerable amount of time, it will also prepare your document in case you wish to use various advanced features of Word, such as:

- Table of contents
- The document map
- Outline view

**Location of Style Related Commands**

Before looking closely at working with styles let’s become familiar with all the locations of the style related commands. Styles can be applied, modified or created using the quick styles gallery or the styles task pane.

**THE QUICK STYLES GALLERY**

The Quick Styles Gallery is located on the ribbon, in the **Home** tab, in the **Styles** group.

**TIP:** Use the scroll bar arrows to move up or down through the gallery or click on the **More** button (located under the scroll buttons) to display the whole gallery all at once.
The Styles Task Pane

To open the Styles Task Pane:

1. Go to the Home tab and locate the Styles group.
2. Click on the Styles group dialogue box launcher button.

Alternative,
  • Use the shortcut keys: ALT+CTRL+SHIFT+S

TIP:
If you click in the Show Preview checkbox the style names will take on the formatting of its respective style.

---

Applying a Style to Selected Text

There are several ways to apply a style to selected text. Whether you wish to apply an in-built style or one you created the methods are the same.

First select the text you wish to apply the style to and then follow one of the methods below:
Applying a Style Method 1: Selecting a Style from the Quick Styles Gallery

1. Locate the Quick Styles Gallery (Home tab, Styles group).
2. Click on the style you require from the gallery (note that Live Preview works with this gallery).

Applying a Style Method 2: Using the Styles Task Pane

1. Display the Styles Task Pane (via the Styles group dialogue box launcher button - see instructions on page 3).
2. Click on the style you require from the styles list on the task pane.

NOTES:

- There is no live preview with styles on the styles task pane, but when you do hover over a style name a tip box will be displayed describing the style’s formatting settings.
- The paragraph or character symbol, listed after the style name, indicates what type of style it is, i.e. the style can either be applied to a whole paragraphs or selected characters.

Applying a Style Method 3: Using the Mini Toolbar

1. Just after you select the text to be formatted move your mouse a small distance up or to the right to display the Mini Toolbar.
2. Click the Styles button and then the style you require from the quick styles gallery which is displayed.

Applying a Style Method 4: Using Keyboard Shortcut keys

To apply style Heading 1 – CTRL+ALT+1
To apply style Heading 2 - CTRL+ALT+2
NOTE FOR APPLYING STYLES:
When working with styles, instead of selecting the text first you may wish to select the style first and then begin typing. All the text you now type will have the style's formatting applied to it until you select another style, or until you click into another paragraph which has a different style applied to it.

NOTE ON IN-BUILT STYLES:
The formatting attributes of some of the in-built styles are dependent upon the theme selected for the document. For example, the style Emphasis appears to give different results when different themes are selected, whereas Heading 1 style appearance will always be the same, unless you yourself modify it. (Themes can be selected from the Page Layout ribbon tab)

Modify a Style

It is possible to edit any in-built style, even if you have already applied it to 20 titles or blocks of text in your document. When you modify a style all the text with the original style applied will be automatically updated and reflect the new changes, and any further text you apply the style to will reflect the changes. You can modify the in-built styles Heading 1, Heading 2 etc.

Modifying a Style Method 1: Using the Modify Style Dialogue Box
1. Display the Modify Style dialogue box using one of the following methods:
   - Right click the style name in the Quick Styles gallery and select Modify
   - Right click the style name in the Styles task pane and select Modify
2. Make all the necessary changes in the Modify Styles dialogue box and click OK

Modifying a Style Method 2: Using the Update to Match Selection Option
1. Select some text that has the style you wish to modify applied to it
2. Make all the necessary formatting changes and leave the text selected
3. Right click the selected text, select Styles and then Update to match selection
   Or,
   Right click the style name in the Styles task pane and select Update to match Selection from the drop-down list which appears
Further Features for Styles

Setting the New Style to be Available from all New Documents

The in-built styles should all be available in all new documents. If you modify one of the in-built styles it may only become available from the current document. You may wish to have the modified in-built style available to you in all future documents that you write and not just the document where you modified it in. You may change this setting either when you are in the process of modifying the style, or at any point afterwards.

To Make the Style Available from All New Documents After it Has Been Created:

1. Display the Modify style dialogue box for the style (right click the style name in the styles gallery or styles task pane and select Modify)
2. Tick the New documents based on this template checkbox located at the bottom of the dialogue box and click OK

Note:
You may be confused by the name of this checkbox as it refers to a template. Note, all new documents are created using the Normal document template unless you specify an alternative template. The Normal template is what tells Word to make all the text you type 12 points, Arial, align text to left, provide one inch margins etc. If you created a style when you were in a document based on a special template it will ensure that the style will be present whenever you create a document using that special template.

Viewing Attributes of a Particular Style

The easiest way to view attributes of a particular style is to go via the Styles Task Pane:

1. Display the Styles Task Pane and hover your mouse over one of the styles in the list.
   A summary of the style is displayed in a box as shown opposite.

   Alternatively, display the Modify dialogue box for a style and look at the description under the preview area.
Managing Styles

You are able to control which styles are displayed in the Styles Task Pane and other aspects such as sort orders. This chapter looks briefly at this topic and the types of options available to you.

Using the Styles Task Pane Options

1. Display the Style Task Pane and click on the Option link at the bottom right of the task pane to bring up the Style Pane Options dialogue box.

2. The Select styles to show: options include:
   - Recommended
   - In use
   - In current document
   - All Styles

   These options can make a difference between just a few styles or over a hundred styles being displayed. You can control what will be shown in Recommended option elsewhere.

   The Select how list is sorted: options include:
   - Alphabetical
   - As recommended
   - Font
   - Based on
   - By type

   TIP:
   The Select formatting to show as styles: options are best left unchecked in most cases as these lead to automatic style definition and the creation of many unwanted new styles.

Using the Manage Styles Button on Styles Task Pane

1. Display the Style Task Pane and click on the Manage Styles button at the bottom of the task pane.

2. Move to the appropriate tab you require for the task you wish to carry out and select your preferences. The tabs are summarised below:
Selecting Text with Similar Formatting

It is possible for you to select all the text in your document with the same style applied to it using a single command. You may then wish to apply an alternative style to that text. For example, if you wish to select all the text which has style Heading 2 applied to it:

1. Open the Styles task pane
2. Right click on the Heading 2 style name and select Select All x instance(s)

Alternatively,
Click in any text in the document with the style applied to it, go to the Home tab, Editing group, click Select and then Select Text with Similar Formatting

This feature is useful if you wish to select all the Normal style text without the headings because you decide you wish to experiment with different font sizes for the body text.

Table of Contents

Constructing a table of contents manually for a long document is likely to take you a long time. Having to manually update it will add on even more time. Use the Table of Contents feature to automatically create tables of contents and update them with just a couple of mouse clicks. Before you can create a table of contents you must first mark text as entries for the table.

Marking Entries for a Table of Contents

The easiest way of marking text is to use Word’s in-built special heading styles, i.e. Heading 1, Heading 2 etc. The advantage of this method is that you are likely to have applied these styles to all your headings in your document already. The heading styles in Word are hierarchical, i.e. heading 1 is the main heading, heading 2 is a subheading and so on. (If you are creating your own styles it is useful to name them carefully and perhaps give them numbers to reflect their hierarchical level.)

Creating a Table of Contents Based on In-Built Heading Styles

If you have used styles Heading 1, 2 etc. to mark your entries the procedure to create a table of contents is very quick and simple.

If you require a simple table of contents with all the default settings:

1. Position the cursor where the table of contents is to be placed
2. Click on the Tables of Contents command (References tab, Table of Contents group)
3. Select either the Automatic table 1 or Automatic table 2 option. An example table of contents is shown opposite.

| Contents |
|------------------|-------------|
| Introduction to Styles | Page 3 |
| Some Examples of Uses of Styles | Page 2 |
| Location of Style Related Commands | Page 1 |
| The Quick Styles Gallery | Page 1 |
| The Styles Window | Page 1 |
| Applying a Style to Selected Text | Page 4 |
| Applying a Style Method 1: Selecting a Style from the Quick Style Gallery | Page 2 |
| Applying a Style Method 2: Using the Styles Task Pane | Page 4 |
| Applying a Style Method 3: Using the Apply Styles Box | Page 5 |
| Applying a Style Method 4: Using the Mini Toolbar | Page 5 |
| Creating a New Style | Page 6 |
| Creating a Style Method 1: Save as a Quick New Style | Page 6 |
| Creating a Style Method 2: Using the Styles Task Pane | Page 6 |
If you wish to create the table of content with a few changes to the default settings:

1. Position the cursor where the table of contents is to be placed
2. Click on the Tables of Contents command (References tab, Table of Contents group)
3. Select the Custom Table of Contents option to bring up the Table of Contents dialogue box as shown below
4. Make any changes necessary:

   The Print Preview section shows you how the different levels of titles will be formatted and which styles the table of contents will be based on. The default styles used are Headings 1, 2, 3

   Select whether to have page numbers displayed

   Select whether to have leader dots and what type of leader dots

   Select an alternative style from the Formats list. **NOTE:** Once you change this setting it is very difficult to return to the basic style you started with.

   Select how many levels of headings to display in the table of contents. Usually just two levels are enough.

   Click on the Modify button if you need to change the formatting/appearance of text in the table of contents. For further details on this feature see page 20, Method 1.

5. Once you are happy with the settings click OK and the table of contents will be generated. An example is shown below:
**Modifying the Table of Contents After you have Created It**

You may return to the Table of Contents dialogue box at any time and change any of the settings and options mentioned in the pages above. It is not necessary to select the table of contents first. Just follow the following steps:

1. Click on the **Tables of Contents** command (References tab, Table of Contents group)
2. Select the **Custom Table of Contents** option to bring up the Table of Contents dialogue box
3. Make any changes necessary and click OK
4. Word will automatically locate your table of contents and will ask you:  
   ‘*Do you want to replace the selected table of contents?’*  
   Respond with **Yes**.

Your table of contents is now updated with all the changes.

**Formatting Text in a Table of Contents**

You may not like the appearance of the text in the table of contents. It may be that Word has made all the Level 1 headings in the table of contents bold or a different colour. It is possible to tone down this unwanted formatting or add any of your own. Before we look at how to do this lets understand what is controlling the appearance of text in a table of contents:

![Image](image.png)

All the **level one** headings are controlled by a style called **TOC 1**

All the **level two** headings are controlled by a style called **OC 2**

There are various ways of formatting the table of contents text:

**METHOD 1: USING THE TABLE OF CONTENTS DIALOGUE BOX**

1. Click on the **Tables of Contents** command (References tab, Table of Contents group)
2. Select the **Custom Table of Contents** option to bring up the Table of Contents dialogue box
3. Click on the **Options** button and the dialogue box shown opposite will appear
4. Select the style you wish to modify, e.g. TOC 1
5. Click on **Modify**
6. The Modify Styles dialogue box will appear. Make all the necessary formatting changes and click OK.
7. Word will automatically locate your table of contents and will ask you:
   ‘Do you want to replace the selected table of contents?’
   Respond with Yes.

**METHOD 2: FORMATTING THE TEXT DIRECTLY IN THE TABLE OF CONTENTS**

The Styles - TOC1, TOC2, etc are set up so that they will automatically update. This means that if you carry out any formatting on any level 1 entry in the table of contents, all the other level 1 entries will take on that formatting too. For example you may add or remove bold to, or change the indentation of one entry and all the other entries will be updated.

**METHOD 3: MODIFY THE TOC STYLES LIKE ANY OTHER STYLE**

Modify the TOC styles as you would any other style. Instructions are given on page 9.

**Updating the Table of Contents**

Once you generate a table of contents, if you edit the document you must also update the table of contents as it does not automatically update itself.

1. Display the Update Table of Contents dialogue box using one of the following methods:
   - Click on the Update Tables command (References tab, Table of Contents group)
   - Click inside the table of contents and press the F9 key on the keyboard
   - Right click anywhere inside the table of contents and select the Update Field option from the drop down menu which appears.

2. Select the option you require from the dialogue box. You would usually select to update the entire table

**Deleting a Table of Contents**

If you get into a muddle with your table of contents it may be easier to delete it and start again. If you just select the table and then use the Delete key on your keyboard there is a risk that you may have left behind some code which may give you errors in the future. Instead do the following:

1. Go to the References tab and locate the Table of Contents group
2. Click on the Table of Contents button and then on Remove Table of Contents
Working with Numbered Headings

You may have a document for which you wish to automatically set up numbered headings. This is actually very easy to do. There are various methods of doing this, but as this guide focuses on styles the one method which will be described here is based on the use of Word’s in-built Heading styles.

1. Use styles Heading 1, Heading 2 etc to apply formatting to your document titles. (Note: you can always modify the Heading 1 style if you are not happy with Word’s choice of format attributes)
2. Go to the Home tab and locate the Paragraph group.
3. Click on the Multilevel List button and select the sixth option form the List Library.

All the headings in your document will now appear numbered. An example is given below:

If you wish to add more headings just type the text and apply the appropriate Heading style to it. The text will take on the formatting from the heading style and will also take on the appropriate numbering.

TIP:
If you wish to promote or demote any heading to a higher or lower level either change the style applied to one of a higher or lower level or use the Increase Indent or Decrease Indent buttons.

TIP:
If you create a table of contents it will have the numbering system added too. You may not be happy with how Word has formatted the text in the table of contents, i.e. the indentations, but you can always modify this.
Tips for Working with Styles

1. Collapsing Text Under a Heading

The ability to collapse parts of your document is very useful if you are working on a long document and you wish to hide away all the text you have proofed or edited so you can just concentrate on the remaining text and scroll through it more easily. This is possible if you have applied styles Heading 1, 2 etc, to your headings.

To collapse a heading:
Hover your mouse over a heading in the document, then click on the blue arrow which appears on the left of the heading. This will collapse the text under that heading.

To expand the heading again click on the clear arrow.

2. Working With The Navigation Pane

Switch on the navigation pane to view a list of all the heading in the document. Only the headings which have had styles heading 1, 2 applied will be displayed.

To switch on the Navigation Pane:
Go to the View tab and click in the Navigation Pane checkbox.
**Collapsing and Expanding:**

If you right click on a collapsed heading you will see a drop down menu with option to expand just that heading or all other collapsed headings in your document. If you right click on an expanded heading you will see a drop down menu with options to collapse just that heading or all headings.

**Promoting / Demoting Headings**

Right click a heading and you will see options to promote or demote it to a higher or lower level heading, or insert a new heading before or after current heading.

**Changing the Order of Chapters**

You can change the order of the chapters around in the document by simply clicking and dragging the headings listed in the navigation pane. Click and drag the heading to the required positions and the contents are moved too. This saves on time consuming cut and pastes when restructuring your document.

Click and drag to a location between two other headings